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Introduction

In this set of exercises we continue our survey of theory and applications of authentica-
tion functions. Here we focus on message authentication codes, digital signatures and
public-key certificates. We begin our study by analyzing some security weaknesses in
MAC functions that use a block cipher in the CBC encryption mode (CBC-MAC) as
a basic building block. Next, we demonstrate the application of a digital signature to
data integrity and data origin protection. Finally, we study public-key certificates and
their application to protection of data source integrity. We will see how to generate
and sign a certificate, and how to integrate it with a web server so to enable secure
SSL/TLS sessions.

Exercise 1

A Message Authentication Code function (C(·)) takes two input variables, a message
m and a secret key K, and generates a compact, fixed length, authenticator (MAC)
for message m (i.e., MAC = C(K,m)). The MAC function C(·) should be such
that an entity who does not have an access to the secret key K cannot calculate a
valid authentication code (MAC) for a given message. When properly implemented, a
correct MAC guarantees both message and message source integrity.

Task 1.1. Cipher Block Chaining MAC (CBC-MAC)

The CBC-MAC construction is depicted in Figure 1. Thus, a message m is broken up
into N blocks and input into the ordinary CBC encryption mode. The only difference
with respect to the CBC encryption mode is the fact that the initialization vector is
set to zero. Finally, we take the last ciphertext CN as a MAC for message m under
the secret key K. Speaking mathematically, calculation of a CBC-MAC for message
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Figure 1: CBC-MAC construction for message m = m1‖m2‖ . . . mN .

m = m1‖m2‖ . . . mN and secret key K can be described as follows:

C1 = E(K, m1 ⊕ 0)
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Ci = E(K, mi ⊕ Ci−1), i = {2, 3, . . . , N}
MAC = CN .

The CBC-MAC construction is known to be secure only for messages of a fixed length.
In this task, we will demonstrate insecurity of the CBC-MAC for variable-length mes-
sages.
Assume that an attacker knows CBC-MACs for messages mA and mB, that is, MACA

and MACB, respectively. However the attacker does not know the secret key (K) used
in calculation of the CBC-MACs. Equipped with this knowledge, the attacker outputs
message mC and the corresponding CBC-MAC (MACC):

mC = mA‖
(
mB,1 ⊕MACA

)
‖mB,2‖mB,2‖ . . . ‖mB,N

MACC = MACB ,

where mB,i is the ith block of message mB. Show that MACC is indeed a correct
message authentication code (CBC-MAC) for message mC and secret key K.

Task 1.2. Detection of Replay Attacks

Recall, in the replay attack an adversary simply replays (re-sends) a copy of a pre-
viously captured (recorded) message (e.g., a network packet carrying authenticated
information). Explain, how can a MAC be used to prevent (detect) replay attacks.

Exercise 2

In this exercise you will use a software product iSafeguard (see Figure 2) to protect
integrity and authenticity of the origin of your data. iSafeguard enables strong encryp-
tion and authentication based on public-key cryptography (i.e., RSA encryption and
RSA digital signature). Your task in this exercise is to exchange an e-mail message

Figure 2: iSafeguard: A tool for providing strong encryption and authentication.

with your colleague such that the message confidentiality, integrity and origin are all
protected.
NOTE: Before proceeding with this exercise, please make sure that iSafeguard is in-
stalled on your machine.
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Task 2.1. Answer the Following Questions

1. You and your colleague use the RSA public-key cryptosystem for encryption and
authentication. What is an essential prerequisite for you to be able to verify
(data and origin) authenticity of an e-mail digitally signed by your colleague?

2. What is a prerequisite for your colleague to be able to ensure the confidentiality
of an e-mail sent to you?

3. You encrypt an e-mail message with your RSA private key and send the corre-
sponding ciphertext to your colleague. Will he/she be able to decrypt it? Please
explain.

Task 2.2. Managing Personal (Self-Signed) Certificates

1. Open iSafeguard “Certificate Manager” (Figure 3) console by first right-clicking
on the golden lock icon in the system tray, then selecting “Certificate Manager”.

Figure 3: iSafeguard: Certificate Manager control panel.

2. Create a personal self-signed public-key certificate by clicking the “Create...”
button. Follow the instructions by the “Certificate Creation Wizard”.

At this stage you have created a RSA public/private key pair and a self-signed
public-key certificate. A self-signed certificate (Figure 4) essentially comprises
your RSA public key and a digital signature of the RSA public key. Note that
your RSA public key is signed with your RSA private key - therefore self-signed.

3. At this stage you and your colleague have to exchange your RSA public keys,
that is, your self-signed certificates. To accomplish this task, first export your
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Figure 4: Self-Signed Certificate for Mario Cagalj.

certificate by clicking on the “Export...” button in the “Certificate Manager”
console. You will be offered to export you private key along with the certificate.
Do you chose to export your private key? Please explain.

Upon exporting the certificate, exchange it with your colleague.

4. Having received a self-signed certificate of your colleague, import it into iSafe-
guard. To accomplish this, in the “Certificate Manager” console click on the
“Import...” button and follow the instructions by “Certificate Import Wizard”.

Finally you are ready to sign/encrypt e-mail messages to be sent to your colleague.

Task 2.3. Encrypting/Signing Messages

1. Compose an e-mail message using your web-based email application (e.g., Web-
mail).

2. Encrypt the e-mail from the previous step such that only your colleague can read
it. To accomplish this use iSafeguard as follows. First make sure the window
that contains the e-mail text has the input focus by clicking your mouse inside
the window. Then, right-click on the golden lock icon in the system tray and
select “Focus Window” and then “Encrypt” (Figure 5). The “Select Recipients”
dialog will pop-up, from which you have to select a desired recipient.

3. Send the encrypted e-mail to your colleague and ask him to read it. To read
the encrypted message first make sure the window that contains the ciphertext
has the input focus by clicking your mouse inside the window. Then, right-click
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Figure 5: iSafeguard: Encrypting a message.

on the golden lock icon in the system tray and select “Focus Window” and then
“Read”.

4. Use iSafeguard to sign and encrypt an e-mail message so that its recipient (your
colleague) can be sure of the message origin and that it hasn’t been modified. In
addition, only the recipient (in addition to the sender) should be able to read the
message. What happens if the recipient does not have an access to the senders
public key? Will she/he be able to decrypt the received message? Please explain.

Exercise 3

In this exercise we will show how to integrate public-key certificates with a web server
so to enable secure SSL/TLS sessions. Our goal is to set up the system (client, server,
certificates, SSL/TLS server) such that an end user does not receive certificate warning
messages as the one shown in Figure 6.

Figure 6: A warning message that informs a user about potential problems with a
digital certificate presented by a web server.
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To accomplish our goal we will use two software products: XCA (for key and certificate
(X.509) management) and Abyss (a simple web server).
NOTE: Before proceeding with this exercise, please make sure that XCA and Abyss
web server are both installed on your machine.

Task 3.1. Creating a Certification Authority (CA)

In this task, we will first create a CA. The role of CA is to issue public-key certificates
to end entities (e.g., our web server). In other words, the CA digitally signs a public
key of a web server and embeds it into the server’s certificate. The CA uses its private
key for signing. In practice, the CA certificate manager (a certificate server) should be
installed on a secure machine (potentially disconnected from the network); the CA’s
private key should be kept highly secure.
The CA also issues a self-signed public-key certificate, whereby the CA digitally signs
its own public key. This certificate is distributed, in a secure way (the integrity of the
CA’s certificate must be protected), to all users who use a certificate issued by the CA
to verify the authenticity of the certificate holder (e.g., a web server).

Figure 7: X Certificate and Key management application.

1. Open XCA and click the “New Certificate” button to start X.509 certificate
creation procedure (Figure 7).

2. Make sure that you select SHA-1 as the “Signature algorithm”; the default algo-
rithm is set to SHA 256 that is not supported by some Windows-based operating
systems. Also, select CA template for this certificate (we are creating a CA).
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3. Select the “Subject” tab and fill in the fields such as “Internal name”, “Country
code”, etc. with appropriate values (for an example please refer to Figure 8).
Generate a new private key by clicking on the “Generate a new key” button.
Note that this is the signing key of the CA.

Figure 8: Creating a X.509 certificate for the CA.

4. Select the “Extensions” tab and set the “Type” of the certificate to “Certification
Authority” (see Figure 8). Click “OK” to finish the certificate creation procedure.

You can check the details of the created CA certificate by double-clicking on it
in the main XCA window under the “Certificate” tab.

Task 3.2. Creating a Web Server Certificate

In this task we create a public-key certificate for a web server. This certificate will be
digitally signed by the previously created Certification Authority (CA) .

1. Again, click the “New Certificate” button in the main XCA window. Select
the “Source” tab and configure the web server certificate properties as follows.
Check “Use this Certificate for signing” and set it to the name of the CA cre-
ated in the previous task. Set the “Signature algorithm” to SHA-1 and choose
“HTTPS server template” from the list of available templates (Figure 9).

2. Select the “Subject” tab and fill in appropriately the available fields (Figure 9). It
is particularly important that you set the “Common name” value to 127.0.0.1.
This will be the IP address (or the corresponding URL) of your web server. If
not set or if this value does not correspond to the real IP address (or the URL
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Figure 9: Creating a X.509 certificate for the web server.

of your web server) each time you try to establish a secure (SSL/TLS) session
with this server, your web browser will give you a warning message about this
mismatch. Finally, generate a new private key for the web server certificate by
clicking “Generate a new key”.

3. Optionally, under the “Extensions” tab you may want to set the type to “End
Entity”. Click “OK” to finish the certificate creation procedure.

Task 3.3. Exporting Certificates

In this task, we will export the certificates created in the previous tasks, that is, the CA
public-key certificate (without the private key) and the web server public-key certificate
including its private key.

1. Open the “Certificates” tab in the main XCA window. Select the certificate that
belongs to the CA and click “Export”. Select a destination and filename where
you want to store the certificate and click “OK”.

2. Repeat the previous step but now export the public-key certificate of the web
server.

3. Finally, we export the private key of the web server. To accomplish this, open
the “Private Keys” tab and select the private key of the web server. The “Key
export” window pops-up. Check the box “Export the private part of the Key
too” and uncheck “Encrypt the Key with a password”.
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Task 3.4. Configuring Abyss Web Server

Figure 10: Abyss web server console.

1. Open the Abyss web server console. Follow the “SSL/TLS Certificates” link to
open the “SSL/TLS Certificates” dialog (Figure 11(left)).

2. We first configure the “Private Keys” parameter. Click the “Add” button to
import the server’s private key that we previously exported using XCA. In the
“Private Key - Add” dialog, choose some internal name for this private key (e.g.,
HTTPSPrivKey) and set the “Action” parameter to “Import” (Figure 11(right)).
Finally, you copy the private key (exported using XCA) into the text box marked
as “Key Contents”. To accomplish this, open the private key in any text editor,
copy and paste it into the text box “Key Contents” (Figure 11(right)). Click the
“OK” button.

3. Next we configure a web server certificate in the “Certificate” dialog. Chose a
name for your certificate and enter it in the “Name” field. Set “Private Key” to
the private key that the certificate is based on (e.g., to HTTPSPrivKey). Next
set “Type” to “Signed by a Certification Authority (CA)”. Finally, enter the
main certificate in the text box “Main Certificate”. As with the private key,
open the web server certificate (exported using XCA) is any text editor, copy
and paste it into this text box. Click “OK” to validate the certificate.

4. In the Abyss web server console (Figure 10) click on the “Configure” button and
follow the link marked as “General”. In the “General” dialog, set the following
parameters (Figure 12). Set parameter “Protocol” to HTTPS, parameter “HTTPS
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Figure 11: Configuring an SSL/TLS certificate and a private key.

Port” to 4330. The “HTTPS Port” is the port on which the host waits for secure
HTTPS connections. Note that the default value of HTTPS Port is 443, however
you might experience certain problems with Abyss web server when using this
value for the port. To save this configuration click the “OK” button. Restart the
web server and make sure that it started to listen on the correct port (i.e., 4430).

5. Finally, create simple html file and name it index.html. Copy this file to the “ht-
docs/” subdirectory in the “Abyss Web Server” directly. Overwrite any existing
index.html file.

Task 3.5. Testing Your Configuration

1. Open a web browser and enter the following address in the address bar:

https://127.0.0.1:4430 .

Do you get any warning message? Which one? Can you explain why do you get
it?

2. We would like to eliminate this warning message. What can we do in this regard?

3. Recall that the CA has digitally signed the web server public-key certificate. So if
our web browser would have an access to the CA certificate (i.e., if it would trust
this certificate), the web browser could successfully verify the digital signature in
the web server certificate and would not report any warning messages.
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Figure 12: Configuring the HTTPS parameters.

To accomplish this goal in a Windows operating system, we can place the CA’s
certificate in the Trusted Root Certification Authorities directory. Here
are the steps to install the CA’s certificate:

(a) Click “Start . Run” and type “MMC”. This opens the “Microsoft Manage-
ment Console”.

(b) Click “File . Add Remove Snap-in”. This opens the “Add/Remove Snap-in”
window.

(c) In the resulting window click “Add”. This opens the “Add Standalone
Snap-in” window.

(d) In this window find the “Certificates snap-in”. Select it and click “Add”.

(e) Select “Computer account” and click “Next”.

(f) Select “Local computer” and click “Finish”.

(g) Click “Close” and then “Ok”. Now you will see the “Certificates snap-in”
in the MMC.

(h) Expand the “Certificates” node, right click on “Trusted Root Certification
Authorities” and select “All Tasks . Import...”.

(i) Click “Next” then select the CA’s .cer file and click “Next” again.

(j) The next step in the wizard should indicate that the certificates will be
placed in the “Trusted Root Certification Authorities”. If so, click next. If
not, fix it.

(k) Click “Finish”.
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This procedure might not work well for Firefox. Alternatively, you can use a web
browser to install the CA certificate. In the “Tools” menu, click “Options...”
(Firefox) or “Internet Options...” (Internet Explorer) to open the dialog through
which you can manage certificates.

4. Now that you have installed the CA certificate, try to access again to

https://127.0.0.1:4430 .

Do you get any warning message?

5. Try to access to the web server by using the following address

https://localhost:4430 .

Do you get any warning message? Please explain your answer.

Task 3.6. Certificate Chain

Equipped with the knowledge from the previous tasks, configure you system (public-
key certificates, web server) such that your web browser can verify successfully (and
without any warning messages) the authenticity of the web server using the following
chain of certificates:

CA cert −→ Intermediate cert −→ Web Server cert .

The CA does not sign directly the web server certificate, but some Intermediate cer-
tificate authority that in turn signs the web server certificate (Figure 13).

Figure 13: An example showing a successfully verified chain of certificates.


